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LIMITED WARRANTY 
New Concepu'licensor(s) makes no warranties. CX:pleSS or implied, including 
wimout limitation the implied warranties of merchantability and fitness for a 
pa.nicuIar purpose, ~ng the software. New Concepts'licensor(s) does not 
warrant,.guarantee, or make any ~presentations ~ding me use or me ~ts of 
the use of the software in terms of its com:aness. accuracy, reliability, cum:nmess 
or otherwise. The en~ risk as to me ~ts and performance of me software is 
assumed by you. The exdusion of implied warranties is not permitted by some 
stateS. The above exclusion may not apply to you. In no event will New Concepts' 
Iicensor(s), and dleir direaors, officers, employees or agents be liable to you for any 
consequential. incidental or indirect damages (including damages for loss of 
business information, and the like) arising out of me use or inability to use the 
softwate even if New Concepts' Iicensor(s) has been advised of me possibility of 
such damages. Because some states do not allow me exclusion or limitation of 
liability for consequential or incidental damages. me above limitations may not 
apply to you. New Concepts'licensor(s)'liability to you for aauaI damages from 
any cause whatsoever. and ~es of me form of me aaion (weather in conttaa. 
tort (including negligence). product liability or omerwise), will be limited to $50. 

In no event will New Concepts'. its direaors, officers. employees, or agents be liable 
to you for any consequential. incidental or indirect damages (including damages 
for loss of business information, and the like) arising out of me use or inability to 
use the softwate even if New Concepts has been advised of me possibility of such 
damages. Because some states do not allow me exdusion or limitation of liability 
for consequential or incidental damages. me above limitations may not apply to 
you. New Concepts' liability to you for aauaI damages from any cause whatsoever, 
and ~es of me form of me aaion (weamer in contraa, tort (including 
negligence). product liability or otherwise), will be limited to $50. 

TRADEMARKS 
This manual and me software (computer program) described in it an: copyrighted 
wim all rights reserved. No part of the Prism software or documentation may be 
reproduced. stoted in a ~evaI system, or uansmirtcd, in any form or by any 
means, mechanical, photocopying. recording. or omerwise, wimout me prior 
written permission of me rcspcctive aumors. 

Priam Image Comaaioa at ProcaIing @ 1991-1993 Ronald Eo Men:er. Priam 
The Maaaal @ 1991-1993 Dino and Ronny Bagdadi. AD .righ .. t:ael'ftd. All 

other product names an: trademarlcs or registered trademarks of their respective 
holders. 
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IntroJuetion 

Thank you for purchasing Prism~ We are glad you have invested. 
in our program and are confident that you will enjoy its ease of use, 
power, and results. By selecting Prism as your image conversion 
utility, you have given yourself the power to convert images from 
other platforms such as the Macintosh TIl series of computers, IBM TIl 

PC compatibles, NeXT, TIl Commodore Amiga TIl and any other 
platform that supports the standard image formats of the computer 
industry. 

With Prism, you will be able to convert foreign and native graphic 
files to native Apple IIGS TII graphic formats to grayscale, 16,256, 
and 3200 colors. Once in Apple IIGS format, you can edit or use 
the images to your liking with programs like HyperStudio ,TIl 

Hypercard IIGS:" DduxePaint II~ Platinum Paint~ 
DreamGrafix TIl and many others. 

Wi Count on lOu 

Prism is the result of over two years of hard work and refinement. 
Please do not illegally copy and distribute copies of Prism to 
anyone. not even your good friends. Piracy is a killer. Please 
encourage your friends to purchase their own copy of Prism. This is 
the best way you can hdp us continue publishing quality software 
for the Apple IIGS. 

Customer anti Technical Support 

Please take a minute to 6.ll out the registration card and mail it. This 
way you will be notified. of any new upgrades and products. 

We always wdcome feedback from our customers. If you have any 
questions. comments. ideas. or recipes to share. please contact us. 

New Concepts can be reached. Monday through Friday 10:00 AM 
to 5:00 PM Central Tune at (815) 338-4227. Please have your serial 
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nwnber on-hand when calling. 

You can also contaCt us at: 

New Concepts 
Suite 2 
665 West Jackson Street 
Woodstock. IL 60098 

or through FAX at (815) 338-4332. 
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What lOu $houIJ Know 

This manual assumes that you have a basic knowledge using 
GS/OStli v6.0. You should also know how to: 

A Use the mouse and keyboard 

A Pull down menus and selea options from pop-up menus 

A Choose from a menu 

A Use the direaory dialog box to load and save files 

A Use keyboard equivalents (such as 6-0) 

Minimum Requirements 

To use Prism you will need: 

A AnAppleIIGS 

A GS/OS System Software version 6.0 (or later) 

A One 3.5" disk drive 

A 1.25 Megabytes of RAM (Random A.t:ass Memory) 

We recommend a hard drive, an accelerator card, and lots of 
memory for &Ster performance when loading, saving and 
processing images. 

Installing Prism 

The Prism Program Disk is not a self-booting disk. You will need 
to start-up your Apple IIGS with your own copy of GS/OS either 
from a floppy disk or from a hard drive. Before you go any further 
make sure to make a backup copy of the original Prism Program 
Disk using your &'vorite program or Apple's FindeL til 

The Prism Program Disk contains a file labeled Prism and two 

direaoties, one labeled Icons and the other labeled Prism.Samples. 
In the Icons directory you will find a file labded Ptism.lcons. In the 
direaory labeled Prism.Samples you will find the two images used 
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in the tutorials (Crush. and Desert) and other images for you to 
experiment with. 
To install Prism follow these steps: 

1 Start up your IIGS. 

2 Insert the copy you just made of the Prism Program Disk 
into a 3.5" disk drive. 

3 Copy the file labeled Prism and the directory Iabded 
Prism.Samples into the desired volume or folder on your 
hard drive or Hoppy disk. 

-I Copy the contents of the directory Iabded Icons into the 
Icons folder in your volume. 

Checking the Ver.rion Number 

To check Prism's version number and other information launch 
Prism and sdect the About .•• menu item under the Apple menu. 
You will need to supply the version number for technical support. 
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Starting Prism 

You can start Prism by launching it from from your favorite 
program launcher. In our example we will use Apple's Finder. 

To launch Prism from the Finder simply double-click on the Prism 
icon (Figure 3-1). You will be greeted by Prism's tide screen. A 
couple of seconds later the screen will blank and you will be in 
Prism's desktop. 

Figure 3-/ The Prism Icon 

Converting an Image 

Let's start by using Prism's most powerful tools: the True Color 
Viewers and Conversion Settings. We must first load an image to 
work on. To do so simply: 

1 Pull down the File menu and select Open Image ... , or 
press 6-0. 

A standard Open Dialog Box will appear prompting you to select 
the file you wish to convett. 

2 Select the file named Crush from the directory named 
Prism.Samples inside of the Prism directory. 

A dialog box with a thermometer (Figure 3-2) will pop up 
displaying the name of the file being loaded and updating you on 
the progress as the file loads. 

Loading: "Crush" __ 

Figure 3-2 The Open Thennometer Dialog Box 
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Immediatdy following you will see another thermometer dialog 
box informing you of the progress as it counts the distinct colors in 
the image. 

Note: Prism comes with the Count Distinct Colors prefomzce 
enabled. If you have disabled this option through the Prifn"mces 
menu, Prism will skip this step. Once Prism is done counting the 
distinct colors in your image, you will be pmented with two 
windows located one atop the other on the top right sUk of the 
desktop. These are the Image Information and the Conversion 
Settings Windows (Figure 3-3). 

Image Information 
Filen.e: Crush 
FOl1lat: GIF (Graphics Interchange FOl1latftl) 

Width: 329 Palette Size: 256 
Height: 2DD Palette Count: 1 

Hmory Used: 63k Distinct Colors: 256 

Conversion Settings 

121 Dithering Color Separation lD 
Global Histogr. I.pact I Proportional ~ 

Rgure 3-3 The Image Information and C'cnversion Settings Windows 

Notice how the Image Information Wmdow displays all rdevant 
information about the image. 

3 Select VIeW True Color or VIeW True Color (Wuie) from 
the Goodies menu. 

A thermometer dialog box will pop up informing you of the 
progress as it converts the image to raw data. 

4 You can now scroll through the image by moving your 
mouse in all directions. 

You will notice that the bottom leftmost Crush soda can in the 
image is lavender while the rest of the cans are .ted. Keep this little 
but important f.u:t in mind. 
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; Select 16 Colors from the Conversion menu or pressG-2. 

Again you will see the f.un..iliar Thermometer Dialog Box informing 
you of the progress as it convertS the image to 16 colors. Right 
under the thermometer bar you will see a line informing you of the 
status of the conversion. This is there for those of you more 
tedmically inclined who would like to know just what Prism is 
doing while you wait for the conversion to take place. After Prism is 
done converting the image. it will display the results in the Full 
VIeW Display. Notice how the bottom leftmost Crush soda can is 
gray in our conversion. If you recall from what you saw in the True 
Color Viewer, it is supposed to be lavender! We can try to correct 
this by changing the settings on the Conversion Settings Wmdow. 
To exit the Full VIeW Display click on the mouse button. Prism 
will now place the converted image in a desktop window tided 
Crush.16 (16 Colors). If you want, you can check again what the 
real color on the Crush soda can is supposed to be by selecting one 
of the True Color Viewers from the Goodies menu and scrolling to 

the bottom right end of the image where the soda can is located. 

6 Select a level of three through the Color Separation 
pop-up from the Conversion Settings Wmdow (Figure 
3-4). 

Global Hinoer. I.pact 

Figure 3-f Selecting a Cclor Separotion Level of 3 

7 Reconvert the image to 16 colors by repeating step 5. 

An Alert Dialog Box will appear prompting you to save the 
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oonversion. At this point you must either choose Yes, No or Cancel. 

A "Crus.h.lI (16 Cal.ars)" ~as nat btl. savld. "auld 
.,~ IOU lIkl to savilt now. 

[ No ] [Cancel] 

FtgUre 3-5 The Alert Dialog 80K 

If you choose Yes you will be taken to the Save Dialog Box where 
you can save the converted image. Once the image has been saved 
Prism will oontinue reconverting the image. If you choose No 
Prism will dose the current 16 Color Conversion Wmdow and 
oontinue with the oonversion. If you choose Cancel Prism will stop 
the oonversion process and leave the current 16 Color Conversion 
Wmdow intact. 

8 Go ahead and click. No to allow Prism to reconvert 
without first saving the current conversion. 

Prism will reconvert the image and display the conversion in the 
Full V.teW Display. This time you should notice that the bottom 
leftmost Crush soda can is the right oolor- it's lavender! 

Raising the Color Separation up one value made a real difference in 
the oonversion. By setting the value to three, we instructed Prism 
not to allow any colors into the palette of the oonverted image 
unless they were at least three values apart. You can now 
understand how important and useful the True Color Viewers are. 
By first checking what the image looked like in its true color (raw 
data) fOrm, you were able to determine that there was a color 
missing and oorrect the problem. 

Now that you have completed your first successful conversion, you 
may want to save it fOr use in some other program. To do so: 

9 Pull down the Fde menu and select Save As, or press 
6-A 
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A standard. Save Dialog Box will appear prompting you to sdea the 
volume or directory where you wish to save the file. Prism has 
already assigned the conversion the name Crush. 16. If you are 
happy with the name. dick on the Save button; if not. rename the 
image to whatever you want and then dick on the Save buttOn. 

Note: Prism ships with the AppmJ Suffix p,qermce enabled. If 
you have disabled this option through the Preformces mmu. Prism 
will use the filename of the original image to save the converted 
image. In OUT case, if you had disabled this option. Prism woulJ 
have left the filename of the image to be saved as Crush. m­
recommmti you leave this option on, just so can keep track of 
. what type of conversions you have performed. 

Reserving Colors 

Prism allows you to reserve colors when converting an image. You 
can instrua Prism to use anywhere from sixteen down to two colors 
per palette when converting an image. This comes in real handy 
when you work with 256 or 3200 color images in paint programs 
that suppon these modes. People who like converting images and 
adding their own multi-colored text over an image will love this 
feature. For example. let's say you wanted to add some titling (text 
captions) to your convened image. If you reserved one color. Prism 
would only use 15 out of the possible 16 colors per palette. The 
reserved color would not be used in the entire convened image. 
You could then go into your favorite paint program and assign any 
color you would like to that unused color to use for your own 
image. This is what you have to do to instrua Prism to use a specific 
number of colors per palette: 

1 Pull down the Apple menu and sdea Preformces. 

2 From the Preferences menu sdea the number of colors 
you would like Prism to use per palette by using the 
Colors Per Palette pop-up menu. 

That·s it! Now every color conversion (not grayscale) that you do 
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will take this into consideration. 

Nou: Prism wiD merve th~ high~st color (number 15) in th~ 
paldu first anti work its way down. So that if you instruct Prism 
to 1m only 14 colors per p~, it wiD merve colors number 15 
and 14 ftom all palettes anti set th~ to whit~. 

Resizing and Applying Effects 

Let's tty using some of Prism's resizing effects. 

Cropping 

This option allows you to crop a 320 by 200 area from an image 
larger than that. We must first load an image to work on. By now 
you know how to load a file. 

1 Go ahead and load the 6.le Desert from the directory 
Prism.Samples (included in your Prism Program Disk). 

You will notice that the image took longer to load and that the 
thermometer moved slower than when we loaded the previous 
image (Crush). The image we just loaded (Desert) is over twice as 
large as the previous one! Just look over in the Image Information 
Wmdow and you will see that Desert is a 640 by 480 GIF, while 
Crush was only a 320 by 200 GIE Which brings us to this point: 
the larger and more colorful the image, the more memory you will 
need and the longer it will take to load and process. 

2 Select Grayscale from the Conversion menu or press 6-1. 

After the image has been converted, pan the image around using 
your mouse. This will give you a fed fur how big the image is. To 
exit the Full View Display just click on the mouse button. Upon 
exiting, the conversion will be placed in a desktop window 
(Conversion Wmdow) tided Desert. Gray (Grayscale). 

Nou: If you want to tmw ~ conversion in th~ FuIJ VtmI 
Displ4y after Prism hIlS plaati it in a winthw, just click on th~ 
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Vzew button, IoCllted on the leftmost position of the Conversion 
Windows Info Bar, right under the Title Bar. 

Let's just say that you are not interested in convening an image so 
large. All you care about is a screen size portion of the image which 
shows the mountains and the douds. To achieve just that, you 
should crop your image to a screen size. To do so: 

3 Pull down the Effects menu and select the Crop to 
Screm ••. option. 

An Alert Dialog Box pops up letting you know that you are about 
to modify the image in memory. You can either proceed or stop the 
operation. We want it to proceed. 

4 Click on the Yes button. 

Immediately after you dick Yes, a Thermometer Dialog Box 
appears letting you know that Prism is preparing the image for a 
crop. Once this process is done, your image will be displayed in 
grayscale (just like when we converted the image to Grayscale) in 
the Full View Display. 

Now you have to select which 320 by 200 area you want to crop 
(keep). To select the area: 

5 Pan the image around with the mouse until what is 
displayed in the screen is the area you want to crop. 

6 Click the mouse button to finish the crop. 

If you look in the Image Information Wmdow, you will see that 
our image was reduced to 320 by 200. Prism has now discarded all 
the extra information from the original image in memory and only 
kept the area which you selected. Now wasn't that easy? You have 
successfully cropped an image. Congratulations! 

You can now go ahead and perform any type of conversion you 
like. If you like the results you obtain after converting the image. go 
ahead and save your conversion. If you think that you can get a 
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better result by changing the Conversion Settings. by all means do 
so. 

Halving 

The halving options are pretty straight forward. You can either 
Halve. Halve Height. or Halve Width an image. Let's use the same 
image we used in the last tutorial (Desert). This time, however, we 

will use a new way to load the image; we will use the Revert option 
from the File menu. 

1 Pull down the File menu and select Revert, or press6-R. 

The Thermometer Dialog Box appears showing you the status of 
the file being loaded. You can see the advantage of just reloading 
the previous image without having to search for it. 

2 Pull down the Effects menu and select Halve, or press 
6-H. 

An Alert Dialog Box pops up letting you know that you are about 
to modify the image in memory. 

This Effect Hill.odify the mage in .elmy. and can 
not be undone. Do IOU wish to continue? 

Rgure 3-6 The Alert Dialog Box 

You can either proceed or stop the operation. We want it to 
proceed. 

3 Click on the Yes burton. 

Immediatdy after you click Yes the Thermometer Dialog Box 
appears showing you the status of the image being halved. Once 
done, you will notice that Prism recalculates the distinct colors (if 

you have the Count Distinct Colors enabled in the Preferences 
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menu} being used in the image and updates the width and height in 
the Image Inrormation Wmdow. 

You are now n:ady to perform any conversion you wish on the 
image in memory. 

Color Effietl 

Prism has some handy color dkcts which you can apply to an 
image in memory before convening it. These are: B/mJ, Mix, Noise 
Reduction. and Sharpen. 

To use these effects simply load an image and apply the desired 
effect by selecting it from the Effects menu. It's that simple! After 
an dkct has been performed you can convert your image to any of 
the conversion modes and save it. 
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THE APPLE MENU 

Under the Apple menu you will6.nd the Ahout ... menu item, the 
Prifn'mces •.• menu item, and any other New Desk Accessories you 
have installed in the disk you booted from. 

About... ~? 

Prtftrtncts •.• 

Control Panels 

Figure 4-1 The Apple menu 

About ••• 6-:' 

This menu item will bring up the About Dialog Box. In it you will 
6.nd infOrmation regarding the program, such as the versio number, 
author's name, credits, etc. 

Priferences ••• 

Selecting this menu item will bring up the Preferences Dialog Box: 

'r,ftr'IC'S 
C33 Correct FiletHpelAuxtHPI 
C33 Count Distinct Colors 
C33 Append Suffix to Filenoaes 
o Fewer Warnings 

Conversion after Open I Mone ~ 

Convlrsion afur Launch I Mone ~ 

Colors Plr Pallttl []l 
[ Cancel) ( Oko, ] [ Sove ) 

Figure 4-2 The Preferences Dialog Box 
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Once inside, you will be presented with the following options 
regarding Prism. 

Correct Filetype/Auxtypt! 

If this option is checked off, Prism will automatically correa the 
filetype and/or auxtype of files which have them set incorrectly. 

Note: Some programs rely on tht fiktyptlauxtypt of a file to 
determint which format it is stored in. Prism wiD changt tht 
fiktyptlauxtypt of a file to tht registtretl Apple fiktyptlauxtypt. 
Ont such txIlmple are GIF files. Usually thtst haVf: tht typt of 
BIN ($06,0000) or TXT ($04,0000). Tht ntW Apple registered 
fiktyptlauxtypt for GIFs is $CO,BOO6. 

Count Distinct Colors 

With this option Prism will automatically count the number of 
distina colors of an image after you load or perform an effect on 
an image. A window with a thermometer will be displayed to show 
you the progress. Prism will then display this information in the 
Image Information Wmdow next to the Distina Colors entry. 

AppmJ Suffix to Filmames 

If this option is checked off, Prism will automatically add a suffix 
of .gray, .16, .256, or .3200 to the filename depending on the 
conversion performed. For example, if you conven an image called 
Bill.Car to 3200 colors, Prism will append the suffix .3200 to 
Bill. Car. The final name would be Bill.Car.3200. 

Ft!Wt!7' mtming.r 

Prism is very careful to warn the user any time an aaion which may 
modify the image in memory or current conversion is about to take 
place. With this option checked off, Prism will not warn you about 
these aaions. 
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Conversion after Open 

This option allows you to chose which conversion Prism will 
automatically apply to an image right after you load it from the 
Open Dialog Box. You can select None, Grayscale, 16 Colors, 256 
Colors, or 3200 Colors through a pop-up menu. Next time you 
open a file, Prism will automatically conven it to the selected type 

using the current Conversion Settings. 

Conversion after Launch 

This option allows you to chose which conversion Prism will 
aut?maticallyapply to an image right after you double click on the 
image's icon in the Fmder. You can select None, Grayscale, 16 
Colors, 256 Colors, or 3200 Colors through a pop-up menu. Next 
time you are in the Finder, just double-click on the image you 
would like to load. Prism will automatically launch, skip the tide 
screen, load the image, and conven it to the preset conversion using 
the current Conversion Settings. 

Colors Per Palette 

This option allows you to select how many colors Prism should use 
on the conversion per palette. You can select anywhere from 16 
down to 2 colors. This option comes in handy if you want to 
reserve some colors in the palette fOr your own use after the 
conversion has taken place. 

Let'S say you want to put a tide on an image. What you would do is 
select 15 from the Colors Per Palette pop-up menu and then 
conven the image. Prism will then conven the image using only 15 
colors per palette, which leaves you one flee color. Take your image 
to a paint program, change the color of the last position in the 
palette (the unused color- always white) to the color you want your 
text to be and type in your tide using the text (font) tool. That's it! 
This comes in real handy when you want to add a tide to a 256 or a 
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3200 color image. 

On the bottom of the Preferences Dialog Box there are three 
buttons: Caned, Okay and Save. 

A Oick on Caned to exit the Preferences Dialog Box and 
leave the settings as they were. 

A Oick on Okay to temporarily use these settings. 

Note: Prism will not sa~ your p".formces upon exiting Prism if 
you click Okay. 

A Oick on Save to save the current pre&rences. Prism will 
use these preferences until the next time you resave them. 

Note: Prism saves these p".formces upon exiting Prism, not after 
you dick the Save button. If for whatever "ason your computer 
was to crash beft" you exited Prism, none of the preftrmces 
wouIJ be saved. Prism also saves any of the options which can be 
toggled on or off with checkmarks ftom the puO-down menus 
(640 mode, Defoult Paktte and Smoothed Reductions). 
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THE FILE MENU 

Through this menu' you will be able to load and save your images 
and exit Prism. 

Open Image ••• 

Save As_ 
Clost 

Quit To... 6T 
Quit 6Q 

Figure 4-3 The Fie menu 

6-0 

This option is used to load all images. Once this menu item is 
selected, you will be presented with a standard Open Dialog Box. 

Select I.age to Open: 
~. R03 (ProDOS) 
IJl!!IDL 51 
Cl [V.Demo.Plcs 
Cl Husic.Apps 
Cl Pics.Misc 
Cl Stuff 
Cl TrueTypt.Fonts 

.0. 
o Show All Files 

( VolUlles ) 

( Open ) 
( Close ) 
( Concel ) 

Figure 4-4 The Open Dialog Box 

The following formats are supponed for loading by Prism: 

A Graphic Interchange Format 111 (GIF) 
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... Interchange File Format'lll (IFF- form ILBM) 

... Tag Image File Format'lll (TIFF- no Packbits or ]PEG) 

... PaintWorks'lll1.0 

... PackBytes 

... Apple Preferred (all types) 

... Super Hi-Res Screen 

... French APP 3200 Color Super Hi-Res Screen 

... 3200 Color Super Hi-Res Saeen 

... Packed 3200 Color Saeen 

... Allison'lll Raw Data 

... VlSionary VID Raw Data 

... ComputerEyes'lllGS 

Prism has a built-in loading filter that will only display the files it 
supports for loadi.lg, in all of its d.i.fferent filetypelauxtype 
variations. On the lower left side of the dialog box is a check box 
labeled Show All Files. Click on this box to show all the files 
(overriding Prism's loading filter) in the current drive or directory. 

To load a file simply click on the filename and click on the Open 
button, or just double-cllck on the filename. After you do so, Prism 
will display a thermometer dialog box to inform you on the 
progress as the file you selected loads. 

Loading: "Crush" _ 

Figure 4-5 The Thermometer Dialog Bole 

Note: Prism wiIlautomaticaUy recognize anti ignore Macintosh 
heatlers ftom GIF files. Prism will also recognize IBM PC anti 
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Macintosh GIF anti IFF Jiles downloaded from Amnica 
Online."" 

If Prism cannot open an image, it will let you know so. If you are 
certain that the file's furmat is supponed by Prism, then there is a 
chance that the file might be damaged or corrupted. 

Revert 6-R 

This option re-Ioads the last file you loaded. This option provides 
fur a quick way to rdoad the previously loaded image without you 
having to search fur it from your volume/directory. For example, 
let's say that you load an image, perfurm a Halve and Sharpen 
effect to it, but you do not like the results after you see the 
conversions. Simply select Reven and it will load the original image 
without any of the effects applied to it. 

Save As ••• 6-A 

This option allows you to save the convened ima~'C back to disk. 
Sdeering this menu item will bring up the standard Save Dialog 
Box which allows you to name the convened image (if you don't 
like the one Prism suggests) and save it to the volume/directory you 
want. 

Ef) .. HD3 (ProDOS) 
2520 frn of 17380 k. ( Volume'S ) 
.OL m 
CJ EV.Dello.PlcS ( Mew Folder) 
CJ Musie.Apps (Open -, 
CJ Pies.Mise . -
CJ Stuff ( Close) 
CJ TrueType.Fonts -0 

~so_v_el_6_c_ol_or_A_s: ____ ~(~==s~o=ve==~] 

IOESERT.6IF.16 I ( Cancel) 

File FOl'llot: I Apple Preferred ~ 

Figure 4-6 The Save Dialog Box 
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Prism allows you to choose in which furmat to save the image 
through the File Format pop-up menu, located in the bottom of 
the Save Dialog Box. The File Format pop-up menu has two 
options: Apple Preferred and 3200 Color Screen. 

The Apple Preferred furmat is supponed by most, if not all, Apple 
IIGS applications. It can handle images of very large sizes in both 
modes and in all color configurations. Prism will aaivate the 3200 
Color Screen furmat if your conversion is a one screen (320 by 200 
pixels) 3200 color image. If not, this item will be dimmed out. 

Close 6-W 

This option will close the aaive Conversion Wmdow. You can 

achieve the same result by dicking on the Conversion Wmdow's 
Qose Box (top left corner of window). 

If you do not have the Fewer Warnings preference enabled, it will 
prompt you to save the image everytime you close a Conversion 
Wmdow that has not been saved yet. If you want, you can override 
the prompting manually by holding down the Option key while 
selecting Close from the File menu, or by holding the Option key 
while clicking on the Conversion Wmdow's Qose Box. 

Quit To ••• 6-T 

This option allows you to quit back to (or actually launch) any 
application you want, not jUst to the program launcher you used to 

launch Prism. 

When you select Qflit To... an Open Dialog Box will appear 
asking you to select which application to quit to. After you have 
selected the desired application, simply dick the Open button, or 
double-click on the name of the application. Of course, you can 

always dick on the Cancel button to abon this operation. 

This option will come in handy after you have converted an image 
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and wish to edit it in another program. Instead of quitting back to 

your program launcher. you can go directly to the program you 
wish. 

Quit 6-Q 

This option simply exits Prism and quits you back to the program 
launcher you used to launch Prism. 
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THE EDIT MENU 

Prism does not utilize this menu at all, that is why it is dimmed out. 
It is there only fOr the use of NDAs (New Desk Accessories) that 
might require iL 

Cllt 
COllI) 
POStf 
Cleol' 

Ftg 4-7 The Edit menu 

MODES, PALETTES AND COLORS 

On the Apple IIGS there are two color modes: 320 mode and 640 
mode. The first mode, 320 mode, is named so because of the total 
number of pixels, or dots, that can fit horizontally on one line on 
the screen. The second, 640 mode, allows a total of 640 pixels to fit 
horizontally on one line on the screen. Prism, like most Apple IIGS 
desktop programs, operates in 640 mode. A program like 
Dduxepaint II or Platinum Paint, fOr example, can operate in both 
modes. 

There are benefits and drawbacks fOr both modes. Using the 320 
mode allows you to have more colors per palette than using the 640 
mode (16 vs. 4); but using the 640 mode gives you a finer 
resolution, or more dots horizontally than using the 320 mode (640 
vs.320). 
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A color palette is defined as the number of colors that you can use, 
or in Prism's case, display, at one time. While the Apple IIGS has a 
total color palette of 4,096 distinct colors (12 bit color: four bits 
red, four bits green, four bits blue), each mode is limited to a 
specific number of colors it can use at one time. 

In 320 mode, the total number of colors you can have in a palette 
is 16. You can, however, have a total of 200 different palettes in 
320 mode, giving you a total of 3200 distinct colors per screen. In 
640 mode, the total number of colors you can have in a palette is 4. 
Through a technique called dithering, 16 colors can be achieved in 
640 mode by placing all possible two-color combinations from the 
four basic colors in the palette side by side to form the other 12 
colors. Keep in mind that these other 12 colors, unlike in 320 mode, 
are not pure colors, but mere optical illusions to achieve a more 
colorful effect. 

In the 16 color 320 mode, you have only one palette to work with. 
That provides you with 16 distinct colors for the entire image. In 
the 256 color 320 mode, you can assign a total of 16 palettes to the 
entire image, providing you with a total of 256 distinct colors. Each 
of the 16 palettes, however, is assigned to a specific section of the 
image, so that the colors of the section to which palette nine was 
assigned, for example, may not be present in anomer section. The 
3200 color 320 mode is just an extension of the 256 color 320 
mode, but instead of assigning 16 different palettes, 200 different 
palettes are assigned to your image (16 colors multiplied by 200 
palettes equals 3200, the magic number). 

The use of 3200 colors has been around for a while. Only until 
recendy have people begun to exploit its uses. By using 3200 colors, 
you can achieve photorealistic images on your stock, out-of-the-box 
AppleIIGS. 
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THE GOODIES MENU 

The Goodies menu gives you access to certain features in Prism 
which will enhance the use of the program. Although not necessary 
to an extent, the following options are useful to hdp you determine 
if your Conversion Settings are correct. Once you understand their 
purpose, you will find them indispensible. 

View Image 

ViN I.oge 
View True Color 
View True Color (Wide) 

Convert to Row Data 

Rg 4-8 The Goodies menu 

This option allows you to view any native Apple I1GS format 
without having to conven it first. It will only be enabled when you 
load a native Apple I1GS format, if not it will be dimmed out. 

View True Color 

This option will allow you to view the original image in its true 
colors. There is a catch to this. Due to the Apple I1GS' limitation of 
only being able to display 16 colors per line, you will only be 
allowed to see through a column of 15 pixels horizontally by 200 
pixels vertically at a time. Each of those 15 pixels can have a distina 
color. The remaining color is black, which serves to cover the entire 
image. You can scroll the image under the column left, right, up, or 
down by simply moving the mouse. 
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View True Color (Wide) 

This option is just like View True Color, but the column is half as 
tall and twice as wide. Actually, there are 2 bars that are swapped 
back and forth rapidly, creating the illusion of a wider bar . This 
option allows you to view a wider section of your image at once. 
The trade-off is that the bar will Hicker as Prism has to swap 
between the two bars. Nevertheless, it is a nice feature that lets you 
view a wider portion of the image in true color. 

Note: When you view an image in either of the two Trw Color 
Vzewers, Prism converts the image to raw data, so that you can 
actuany see ftom an of the 4,096 colors availabk, if need be. 
Of course, since the Appk IIGS only has 12-bit graphics, you may 
not see any colors beyond that. So if you were to view a 24-bit 
image (that's ftom a paktte of 16. 8 minion colorsO, many of the 
colors wou/J be representations of the true colors. If you use an 
accekrator such as the Transmt'1' GS""or Zip GS""your display 
wiD flicker kss. 

Convert to Raw Data 

When an image is loaded into memory, it is loaded with a specific 
palette or set of palettes. Because of this, when Prism applies an 
effect, it is restricted to use the colors in that palette(s). Conven to 
Raw Data removes the palette restriction on an image. 

Some effects try to add colors to the image to enhance its 
appearance. When you apply such an effect, Prism, by default, will 
remap the new colors (use the most similar colors already in 
existence from that image's palette) instead of adding new colors. If 
you conven the image to raw data first and then apply an effect 
which deems necessary the addition of colors, Prism will add the 
necessary colors that are not currendy in the palette. 
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THE CONVERT MENU 

This is where it all takes place. From here you will instruct Prism to 
magically convert an image from one format to another, all while 
you are constandy updated of the progress. 

GrosSeale a1 
16 Coiors a2 
256 Colors a3 
3200 Colors a~ 

., 6~0 lode 
Default Polette 

Figure 4-9 The Convert Menu 

The Convert menu is used to convert an image to any of the 
following formats: 

~ Grayscale in 320 mode 

~ 16 Colors in 320 mode 

~ 256 Colors in 320 mode 

~ 3200 Colors in 320 mode 

~ Grayscale in 640 mode 

~ 16 Colors in 640 mode 

Once you load an image, perform any effect desired and sdect the 
Conversion Settings, you are ready to make your conversion to the 
desired format. 

To do so sdect the appropriate format from the Conversion menu 
and let Prism do the £est. If you sdect the Grayscale, 16, or 256 
Color format for conversion, a thermometer dialog box (Figure 
4-10) will pop up informing you on the progress and status of the 
conversion. If you wish to cancel the conversion in progress just 
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press ,6-. (period) at any time. 

Converting to 16 colors ... 6. to cancel 

Status: Generating converted pixe I .op 

Rgure 4-10 The Conversion Thennometer Dialog Box 

If you select the 3200 Color format for conversion, you will be 
taken to a black screen where the conversion will take place. A 
horizontal bar (the Conversion Bar) of 15 lines tall will move down 
the screen as it convertS the image to 3200 colors line by line. As it 
moves past the first 15 lines of the image towards the bottom of the 
screen. you will see that the lines left above are displayed in 
grayscale. Do not worry, this is the normal process. If the image is 
taller than one screen (200 lines). the Conversion Bar will stop at 
the center of the screen and the image will scroll up past the bar. 
This way you will always know at what point of the conversion you 
are at. Once the conversion is done. it will be displayed in full 3200 

colors. If you wish to cancel the conversion in progress just press 
,6-. (period) at any time. 

After a conversion is performed the result will be displayed in the 
Full View Display. If the converted image is larger than a screen 
(320 by 200 pixels) you may move the mouse in every direction to 
pan the image around the screen. 

Once you are done viewing the image. click the mouse button to 
return to Prism's desktop. The converted image you were just 
viewing will be placed in a window on the desktop. The Title Bar 
on each Conversion Wmdow will identify the conversion by 
conversion type (ex: Grayscale. 256 Colors. etc.). 

Grayscale 6-1 

This option will convert the loaded image into grayscale. This is the 
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&Stest of all conversions. None of the conversion settings apply to 

grayscale. Prism will automatically use the best grayscale palette for 
the image. 

16 Colors 6-2 

This option will conven the loaded image into 16 colors. Prism will 
rescale the number of colors of the original image to use a 
maximum of 16 colors. 

256 Colors 6-3 

This option will conven the loaded image into 256 colors. Prism 
will rescale the number of colors of the original image to use a 
maximum of 256 colors. 

3200 Colors 

This option will conven the loaded image into 3200 colors. Prism 
will rescale the number of colors of the original image to use a 
maximum of 3200 colors. 

640 mode 

When this item is sdeaed, a checkmark will appear next to it. 
When you enable this option, Prism will allow you to conven your 
image to any of the supported 640 color modes: Grayscale and 16 
Colors; the other two modes, 256 Colors and 3200 Colors, will be 
dimmed out. 

This option is very useful to conven images for use in Hypercard 
IIGS, HyperStudio, or any other application that supports 640 
mode graphics. 

Default palette 

This item can only be used when the 640 mode option is enabled. 
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When this item is enabled, a checkmark will appear next to it. This 
option will force Prism to convert an image to 640,16 color mode 
using the delilUlt Apple palette (the same one used in the Finder~ 
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THE EFFECTS MENU 

Through the different effects found under this menu, you can 
manipulate the image to fit your needs. You can change an image's 
size and perform various color enhancements to it. The first set of 
effects listed are the ones that affect an image's size: Crop to Screen, 
Halve. Halve Height. Halve Width and Reduce to Saeen. The 
second set of effects are the ones that affect an image's colors: 
Blend, Mix, Noise Reduction and Sharpen. 

IffmJW 

Correct Aspect Ratio 
Crop to ScreeD.-
Halve 4H 
Halve Height 
Halve Nidth 
Reduce to Screen 

i-I SIIoothed Reductions 

Blend 48 
Hix 4H 
Moise Reduction 4N 
Sharpen 

Rgure 4-1 1 The Effects Menu 

Note: When performed. most of the ejficts wiD modify the image 
in memory. You wiJl be notified of this through an Alert Panel 
If you have the Fewer lWlrnings option in the Preferences menu 
enabled. Prism will not bother prompting you every time you 
perform an effect. If you want to manually override the warnings, 
just hold down the Option key before you select any ejfict. 

Correct Aspect Ratio 

Using this effect will try to correct the aspect ratio of some images. 
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This option will only be enabled when you load GIFs that are 
meant to be displayed on a venical resolution of 240, 480, 600, 
768. or 1.024 or Amiga interlaced IFFs. The pixel ratio of an IBM 
PC is 1.3 to 1; the pixel ratio of an Apple IIGS is 1.6 to 1. If you 
think. that your image is slightly longer than what it should be. try 

this effect. 

Crop to Screen ••• 

This effect will crop a screen's worth (320 by 200 pixels) of data 
from the image in memory. This option will be dimmed out if the 
loaded image is not larger or is smaller than a screen's size. 

To use this option just load an image larger than one screen. Select 
Crop to Screen ••• You will be presented with a thermometer dialog 
box showing you the progress as Prism prepares the image for a 
crop. Next. Prism will display a grayscale version of the image on 
the screen. By moving the mouse in any direction you can view the 
entire image. To select the ponion of the image you would like to 
crop just position the part of the image that you want so that it is 
all visible on the screen and click the mouse button. Prism will then 
dispose the parts of the image which were not visible and leave the 
screen that was visible unaffected. 

You may then apply any other effect you would like. After that 
proceed to convert the image to the desired mode. 

Halve 6-H 

This effect will halve both the height and width of your image. This 
effect comes in handy when you load an image which is 640 by 400 
pixels and want it to only take up one screen. 

Halve Height 

This effect will reduce the height of your image by ha1£ If an image 
seems too tall and stretched out, selecting this effect should improve 
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its appearance. 

Halve Wulth 

This effea will reduce the width of your image by hal£ If an image 
seems too shott and fat, selecting this effea should improve its 
appearance. 

Reduce to Screen 

This dfea will force the image to fit into one screen. Prism will 
shrink the image (not crop) into one screen while preserving its 
original aspea ratio. 

Smoothed Reductions 

When this item is seleaed, a checkmark will appear next to it. 
When an image is resized with the Crop to Screen .•. , Halve, Halw 
Height, Halw Wu/th, or Reduced to Screen effects, Prism has to 
remove lines or columns from the image. By doing so, Prism is also 
removing any color information that was there before. 

When you enable this option, Prism will allow any resizing to be 
done taking into account the colors in the lines and/or columns to 
be removed. Prism will aaually average the colors to be removed to 
the adjacent pixels and remap, or add new colors if the image was 

previously converted to raw data, the necessary colors, thus creating 
more subde transitions from line to line, column to column. This 
allows for a reduction of your image's size without compromising 
quality. For best results, we recommend you leave this option on at 
all times. 

BlmJ O-B 

This effea will look for hue (color) splits, the area between two 

similar hues, and generate a new color which blends in between the 
two hues to make a smoother transition between the hues. This 
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option can greatly improve the quality of your original images. 
Blend will remap the generated colors. or it will add the new colors 
if you have previously converted the image to raw data. 
Imagine having a sequence of the following pixels: black. black. 
black. black. white. white. white and white (Figure 4-12). After you 
apply this effect. the sequence will change to: black. black. black. 
gray. white. white and white (Figure 4-13). To obtain smooth 
conversions on choppy images. we recommend you use Blend. 

•••• 0000 
Figure 4-12 /mage before Blend 

•••• 0000 
Fig.ne 4-13 Image afl:er Blend 

Mix a-M 
This eHect will look for hue splits between two similar hues and flip 
the two innermost pixels to simulate a smoother transition between 
the two hues. This eHect will not add any extra colors to your 
image. Imagine having a sequence of the following pixels: black. 
black. black. black. white. white. white and white (Figure 4-14). 
After you apply this effect. the sequence will change to: black. black. 
black. white. black. white. white and white (Figure 4-15) . 

•••• 0000 
Figure 4-14 /mage before Mix 

Figure 4-15 /mage after Mix 
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Noise Reduction 6-N 

Using this effect will remove any stray pixels. usually referred to as 
noise. from the image. As result. this effect will often remove several 
unnecessary colors from the image. TIlls effect is recommended 
when convening images that were digitized using the 
ComputerEyes or VISionary (AST V ISionPlus TIl ) video digitizers. 

Sharpen 

Using this effect will sharpen the image. Prism will look for smooth 
color transitions and make them more sharp from one color to 
another. 

Note: Evny time you perform an 4foa Prism wiD update the 
Image Information Window to rejkct the changes. If you have 
checked off the Count Distinct Colors option from the Preftrences 
menu, a thermometer dialog box wiD pop up showing you the 
progress as it recalculates the distinct colors. 
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CONVERSION WINDOW 

The Conversion Wmdow contains a convened image. You can 
have up to four different Conversion Wmdows on your desktop. 
each one containing one of the diflerent types of conversions 
(Grayscale. 16 Colors. 256 Colors and 3200 Colors). 

Rgure 4-16 The Corwersion WindCNI 

The Conversion Wmdow's TIde Bar displays the name which will 
be used to save the conversion with the appended suffix (if the 
option was selected from the Preferences Dialog Box) and the 
conversion type (ex: Grayscale. 256 colors. etc.) in parenthesis. Just 
below the TIde Bar is the Info Bar. It contains the View button. the 
width. height and mode (320 or 640) of the convened image 
(Ftgure 4-16). 

Each Conversion Wmdow can be manipulated. You can move the 
window by clicking and dragging the window by its TIde Bar. You 
can scroll through the image using the Scroll Bars along the right 
and bottom sides of the window. You can resize the window by 
using the Zoom Box on the top right of the window or the Resize 
Box on the bottom right of the window. You can dose the window 
by clicking on the Oose Box. on the top left corner of the window. 
To view any convened image in the Full View Display just click on 
the Vtew button in the Info Bar. 
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THE IMAGE INFORMATION WINDOW 

The Image Information Wmdow displays the filename. format. 
width. height. memory used. palette size. palette count and the 
number of distinct colors of the current image in memory. 

Filename 

Image Information 
Filen.e: Crush.32DD 
FOfllot: Apple Preferred 

Width: 320 Palette Size: 1& 
Height: 2DO Pol.tt. Count: 200 

Mellor" Used: 38k Distinct Colors: 129 

rtglle 4-17 The Image Information Window 

This entry displays the name of the aurent image in memory. 

F0171l4t 

This entry displays the format of the current image in memory. 

Wulth 

This entry displays the width in pixels of the current image in 
memory. 

Height 

This entry displays the height in pixels of the current image in 
memory. 

Memory Used 

This entry displays the amount of memory in kilobytes that the 
rurrent image uses. The larger the image. the more memory it uses. 
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Palette Size 

This entry displays the total number of colors per palette of the 
current image in memory. 

Some image formats stOle their palette information as raw data. 
These include IFFs. TIFFs. Allison Raw Dara. VISionary Raw Data. 
ComputerEyes GS or any image which you have convened to raw 
data using the Convert to Raw Data option from the Goodies 
menu. When one of these images is loaded. the Palette Size entry in 
the Image Information Wmdow will read Raw Data. 

Palette Count 

This entry displays the number of palettes of the curlent image in 
memory. Every time you perform an effect which affects the size of 
the image in memory. the Palette Count will be updated. 

When you load an image which stores its palette information as raw 
data or conven an image to raw data using the Convm to Raw 
Data option &om the Goodies menu. the Palette Count entry in 
the Image Information Wmdow will read N/A, to signify that there 
ate no distinct palettes. 

Distinct Cowrs 

This entry displays the total number of colors of the current image 
in memory. This option can be turned on or off &om the 
Plefelences Dialog Box. If turned off, images will load slighdy 
faster and N/A will be displayed instead. 
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THE CONVERSION SETTINGS WINDOW 

The Conversion Settings Window allows you to change the way the 
aurent image in memory will be convened. By changing the values 
of the Color Separation and the Global Histogram Impaa and 
setting the Dithering check-box on or off. you can enhance the 
appearance of the image after conversion. 

Conversion Settings 
183 Dithering Color Separation o:::J 

61obol Histogrcallpoct I Proportional ~ 

Figure 4-18 The Ccnversion Settings Window 

Dithering 

By setting the Dithering check-box on, Prism will apply dithering 
to the image once it converts it. Dithering is a technique that puts 
different colored pixels next to each other in order to simulate more 
colors. For example, by dithering black and white, you can produce 
gray. We recommend you leave this option on all the time for it 
enhances the quality of the convened image. 

Note: Dithering Joes not affict Grayscale conversions. 

Color Separation 

Color Separation determines how similar {or close in value} the 
colors in a palette are. By specifying a lower value, Prism will allow 
similar colors to be included in the convened images palette. On 
the other hand, by specifying a higher value you let Prism know 
that it should only allow colors that are not too similar to each 
other to be included in the convened image's palette. 

You can selea the Color Separation value through the pop-up 
menu in the Conversion Settings WIndow. To change the setting 
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just click on the Color Separation pop-up menu and select the 
setting you desire. The various settings range from Off to 7. A value 
of 2 is the default value. Setting the Color Separation value to Off 
will just take the most used colors in order. Setting the value to 1 
will skip every other color. Setting the value to 2 will skip every 
second color and so on. 

Figure 4-19 The Color Separotion pop-up menu 

GlohtJ Histogram Impact 

Global Histogram Impact will determine how well your image will 
convert. If you try to understand the following concepts, you will 
tap much of Prism's power. 

A histogram is a measure for determining the amount of color 
usage. For example, the more the color red is used in an image, the 
higher the histogram value for that color will be. 

Prism uses two types of histograms: local and global histograms. A 
local histogram is a measure that determines how much each color 
is used in each line of an image. Each line can have a different local 
histogram value. A global histogram is exactly the same as a local 
histogram except that it applies to the entire image. Global 
Histogram Impact takes the value of the the local histogram of 
each line and adds it to the global histogram. By specifying a higher 
or lower setting, you can assign how much impact the global 
histogram will have on the image once it is converted. A higher 
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setting will cause the global histogram to affect: the 6.nal image more 
than a lower setting. 

Let's say that there is a lot of green on a small area in an image, but 
not really anywhere else. By raising the Global Histogram Impact 
setting, you can have Prism give less priority to that color in the 
image because it only appears in that area (locally) and not 
anywhere else in the image (globally). 

You can select the amount of impact through the pop-up menu in 
the Conversion Settings Wmdow. To change the setting just click 
on the Global Histogram Impact pop-up menu and select the 
setting you desire. The various settings range from Off to 
Maximum. Proportional is the default value. 

Conversion Settings 

181 Dithering Color 51 Off 

L_~.IJIil~iIi1II'~I:ill'l~I~~~~ Proportional 
Minialll 
Low 
Medilll 
High 
Maximlll 

Figure 4-20 The Gobal Histogram Impact pop-up menu 

Note: Thnr is no specific science or magical combination for 
Color Separation and Global Histogram Impact. You must play 
with diJformt combinations to achieve the best results. The 
defaults we suggest art usuaIy a good starting point. but it all 
varies depending on the image you are trying to convert. 

Always check to see what the image really looks like with any of the 
True Color Viewers. These can provide you with a pretty accurate 
preview of what the image should like after an optimum conversion. 
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COLOPHON 

,",,'n'nn & Ronny Bagdadi. 

This manual was designed and tared out on a NeXTstation 
TumoColor using RightBrain PasteUp, Altsys VtmlOSO, and 
Appsoft Image. 

We would have used a Macintosh- but why when you can be a step 
ahead- NeXTSTEP. 
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